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1. Installing WeatherCast

WeatherCast requires the following PC specifications
* Windows 95, 98 or NT4.0

* 32Mb RAM

* Pentium or similar processor

» A screen resolution upwards of 800x600

*  Modem (56K minimum)

=Y

.1 Installing WeatherCast on to the hard disk

Place the CD-ROM in the CD-ROM Dirive.

The installation program should run automatically. At the Welcome page click
on Next.

Click on Next to install WeatherCast in your chosen directory.

Click on Next to add WeatherCast to the Programs folder in the Start menu.
WeatherCast will then be installed. Once the installation has been completed,
click on Finish to restart your computer.

A
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If the installation procedure does not start automatically:
Double-click on My Computer on the Desktop.

Double-click on the CD-ROM drive.

Double-click on Setup.

Now, follow steps 2 to 5 of the above installation procedure.

arwnE

1.2 Procedure before using WeatherCast

To launch WeatherCast click on Start (Windows Task Bar). Select Programs
and click on WeatherCast.

Before you can start using WeatherCast, some user details need to be entered.
These details were included when you received the WeatherCast CD-ROM.
Without this information it will not be possible to gain access to the PA
WeatherCentre computer system.

The user details will appear the first time WeatherCast is opened, after which you
can locate your user details by selecting User in the Settings menu. After
entering the user details, click the Activate User button to confirm your details.

You will then need to enter your communication details.
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Under Communication Type you will need to select the method of connecting to
PA WeatherCentre. Unless otherwise instructed by PA WeatherCentre, this will
be via a modem. Click on the arrow to the right of the drop-down list to select
the method of communication.
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Under Modem, select the modem that your PC is to use for downloading the
weather information from PA WeatherCentre. The modem should already be
installed under Windows.

1. Select the telephone number from the list available. If you are dialing
through a switchboard, remember to include the outside line digit (usually a
“9”). Click on OK to close the window.

2. You will now need to choose the weather data you wish to download by
selecting the Data collection option in the Settings Menu. More detailed
descriptions of this are provided in Section 3. Downloading Weather
Information which can be found later in this Manual.

3. Click on your chosen weather data requirements and select your desired
region by clicking on the Select Region button in the bottom left of the
screen.
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4. Once your chosen region is displayed (represented as white dots on a map)
close the window and select OK to save settings.

5. Close the Data collection settings screen by pressing OK.

It is possible to instruct Windows to select or de-select audible signals from the
modem. To do this, click on Start in the Windows tool bar for:

» Settings
e Control Panel
e Modems

* Properties
e« Connection Tab
« Advanced ...

Under Extra Settings you are able to enter modem settings. The following
settings apply to modem noise:

LO Low Volume MO Speaker always off
L1 Low Volume M1 Speaker on until connection is made
L2 Normal Volume M2 Speaker always on
L3 High Volume M3 As M1 but speaker off during dialling

The setting “L1 M1” will set the modem speaker to a low volume and switches
the speaker off as soon as a connection is made. Additional information on
modem settings can be found in the instruction manual which came with the
modem.

1.2.1 ISDN

WeatherCast downloads the files with weather information from a computer
system of PA WeatherCentre. This computer system is called a Bulletin Board
System (BBS). Files can be downloaded from this system when you have a
modem or ISDN-adapter in your PC.

When you have an ISDN adapter it is necessary to use the X.75 or V.120
protocol. The use of the X.75 protocol is preferred. A 'protocol’ is a language
which is used by the computer to communicate with another computer.
Computers can only communicate with each other when they use the same
protocol. The X.75 and V.120 protocol are standard protocols for communicating
with a BBS system. Please use the manual of your ISDN adapter for the
installation procedure.
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2. Getting started with WeatherCast

Start WeatherCast by clicking on its icon which can be found in the Programs
section of the Start menu on the Windows task bar. When you open

WeatherCast the screen will look like this:

Menu bar Tool bar

WeatherCast status Communication Program

PA WeatherCentre Ltd.



2.1 Menu bar

The menu bar contains the names of the main menus. You can read the menus
by activating the drop-down menu. Place the mouse cursor on the name of the
main menu and then left-click once. Most of the options in the drop-down menu
indicate clearly what they are for. For example, the Data collection option in the
Communications menu is used to select the weather data to be downloaded by
modem from PA WeatherCentre.

Some options are followed or preceded by a symbol:

A ‘tick’ is the standard way of indicating that an option is selected. By
selecting an option that is already ticked, you de-select that option.

For example, when you click on the Automatic download option from the
Communications menu, this option will be ticked. The Automatic download
option is now selected. For as long as this option is selected the most recent
weather data will be downloaded by modem from PA WeatherCentre
automatically and at regular intervals. If the Automatic download option is
selected, a progress bar will appear in the status bar. As soon as the
progress bar is empty, the most recent data will have been collected.

When an option is followed by three dots, it means that it leads to a dialogue
box in which additional options and settings can be selected.

If an option is followed by an arrow head, then the option consists of a
number of further options. Clicking on the main option automatically
generates a drop-down sub-menu.
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2.2 Tool bar

The tool bar is displayed above the display window and below the menu bar. The
tool bar contains icons (small pictures) of options which are frequently used. The
icons give fast access to the most frequently used options in WeatherCast. You
start the option by left-clicking on the icon.

el WA |WHENE b L CEER | bERE S0 20
Select or de-select Tool bar in the Image menu to display or hide the tool bar.
You can also tailor three icons on the tool bar to suit your needs. The following

icons can be changed by right clicking on them to reveal a list of options, as
shown in the example below.

e
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Precipitation Radar images

European Forecast images

L]
2

European Satellite images
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kinirumm temperature

Maimum temperaturs
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Tool Bar Icon
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Action

Opens a display which has been saved previously

Saves all displays

Prints the active view

Downloads the selected data via the modem

Disconnects the telephone connection

Zooms in on image in active window

Zooms out of image in active window

Displays first image

Displays previous image

Stops running images as a movie
Starts running images as a movie
Displays next image

Displays most recent image

Opens WeatherCast Help
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Presentation of weather information

Text view of short range weather forecast

e

Text view of medium range weather forecast

Table of observations
Table of hourly forecast information

Table of 3-hourly forecast information

|51 |5 | (&l

Table of daily forecast information

Graphical representation of observations
Graphical representation of hourly forecast information

Graphical representation of 3-hourly forecast information

sl bzl o

Graphical representation of daily forecast information

i
P

Precipitation Radar images

European Forecast images

[

European Satellite images
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2.3 Status bar

The status bar is situated below the WeatherCast window and has the following
components:

| Collect weather data |Commurication program started [Fip) rllllllllll | Mon 30 Aprﬂ:ﬂ_

1. The leftmost field provides information about icons to which the mouse cursor
is pointing in WeatherCast, e.g. “Collect Weather Data”.

2. The next field to the right indicates the status of communications. It allows you
to monitor which action is being performed when downloading information by
modem from PA WeatherCentre. It can show, for example, “file collected” or
“‘Downloading radar image”. When you have finished downloading, the
message “Data collection and processing completed” will appear.

3. The next field to the right of the communications status provides information
regarding automatic downloading. Once the Automatic download option has
been selected, it contains a filling progress bar which subsequently empties.
As soon as the progress bar is empty, new data are downloaded via the
modem and the progress bar is filled again.

4. The right-most field provides information on the actual day, date and time on
your PC.

11
PA WeatherCentre Ltd.



2.4 Communication

Once WeatherCast has started you will notice a small WeatherCast logo on the
far bottom right of your PC screen. If you double click on this another window will
become available to you. From this Modemaccess window, you can follow the
status of the communication program.

12:09 Commurication program started [(Modem)

12:50 Digling

1311 Connected to PA WeatheriCentre to 17:13:11

1312 & \wieathercentre
WEATHERCAST /292 Vaush

Landon
. paweathercentie.com dSWIY
# Phone: 020 - 7963757

' |BES GetWwhk???7ab.”

BES Get Wi???7ab.”
BBS Last Tkdduuab.* 1012
BBS Last Trdduuab * 3012
BBS Get TI7772ab."

PA WeatherCentre Ltd.
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3. Downloading Weather Information

Using the WeatherCast program you can request and display up-to-date weather
information from PA WeatherCentre via a modem connection. It is up to you
which information to request. The more data you request, the longer it will take to
download those data. Once you have selected the option Data Collection from
the Settings Menu, a dialogue window will appear.

Data collection settings
 Options [

[ Radar inages

T Disservations

rmbﬂqala: data callection

| Communication program started (Modem] | ed 14 Mar 16:18

You can use the dialogue window to indicate which type of weather information
you wish to request. Weather data are subdivided into four different groups:

* Forecasts

* Observations

* Radar Images

» Satellite Images

13
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These groups are again sub-divided into various categories. You can select or
de-select particular groups or particular categories within a group. To select or
de-select a group or category, you select or de-select the box in front of the
group or category name. If a tick is shown, the group or category has been
selected. A tab will then appear on the top of the dialogue box. Click on the tab to
access the selection category as shown below:

[ | Communication program started Modem] I [ wed14Mar1gas.

14
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™ 'WeatherCast

File Commurication Visw Image Window Settings Help

CHE g A SN EHNE] B G BEHER S 0 2

¥ Pressure maps

T Temperature maps [min] Euwape
l' Temperature maps (mas) Europe
17 F"@'é@t@_t!pﬁmbﬁ?;[daﬂy]'.ﬁi@ge
T Precipitation maps [6-hauil) Europe

| Commurization program started [Madsm) | wied 14 Mar 16:21

3.1 Forecasts

Within the Forecasts group, you can choose to download the regional weather
forecast, atmospheric pressure charts, precipitation charts or temperature charts.
If you are not subscribed to one or more fixed regional weather forecasts, you
can select a specific region using the button Select Region. Once you have
pressed Select Region, a map of the British Isles is displayed. By clicking on this
geographical map, you bring up the selected town and activate the region in
which this town is situated. All towns and villages within this region are
highlighted in white. You can select more than one region by keeping the Ctrl
key down and again clicking on the map.

You can find a particular town in the British Isles by right-clicking on the map and
selecting Search location. Type the name of the place you are looking for, and
click OK. The town will then be shown on the geographical map. Don't forget that
you have not yet selected the region corresponding to this town! By using your
mouse to left-click on the town on the map you select the region. Having selected
one or more regions, you close the map and reply with OK to the question “Do
you wish to save the selected regions?”

15
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ﬁﬂlitish Izsles map

3.2 Radar Images

Within the Radar images group, you can set the number of images you wish to
be downloaded. Radar images are produced every quarter of an hour. By default,
always the most recent radar images are requested. It is possible, however, to
request earlier images by selecting Historic radar. This allows you to select
radar images by a Start and End Time.

3.3 Observations

Within the Observations group, you can choose to request the observations
within the same time period as the radar images or customise the period. Should
you wish to customise the start time and end time of the observations to be
downloaded, you should select Period and Frequency. This allows you to
choose the frequency of the observations as well as the start and end times.

16
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3.4 Satellite Images

Within the Satellite Images Group, you can indicate which type of satellite image
you wish to request. For both types, you can also set the number of images to
request. Only the most recent satellite images can be downloaded.

3.5 Automatic Data Collection

The last option in the Data Collection dialogue window is Automatic Data
Collection. This allows you to set how often new data should be downloaded
automatically.

There are various options available when downloading WeatherCast data
automatically:

» Firstly, you need to specify how often you want WeatherCast to automatically
collect data using the “Get new data every” option. The default setting for
automatic downloads is every 15 minutes.

* Period. You can select a time period, throughout the day, during which
WeatherCast will collect data. To do this, simply enter a Start time and an
End Time.

* You can also use the Automatic collection always enabled function to
ensure WeatherCast will always automatically collect data every time
WeatherCast is started.

To activate the automatic download, select Communication then Automatic
Data Collection (after the Data Collection dialogue window has been closed).

Data collection settings

Elptions] Forecaslsi Fadar imagesi Dbservatinnsi Satellite images  Automatic data collection ;

Get new data eveny :’ omis ﬁ mikLtes

: : o ey i

¥ Period Start time :E DE:00 |
: o |

End time ::! 10:00 5|

[ Automatic collection always enabled

W 0K x Caricel l
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4. Displaying Weather Information

The data that have been downloaded via the modem are saved to the hard disk
on your computer. After processing, you can view these data using options in the
View Menu:

« Weather forecast
« Observations

« Radar images

« Weather maps

« Satellite images

The most commonly used data are represented by icons on the toolbar, as
shown in 2.2.

You can customise the display by right-clicking on the displayed data. You will
then be given a menu of options. You can select the options by left-clicking on
them. After closing, the program returns to the original settings. It is also possible
to customise the displays permanently by using the following options in the
Settings Menu:

« Text Views
 Table Views
* Map Views

Once you have chosen a particular view, by default a new window is always
opened. This means that view several displays at the same time. The Window
menu allows you to see which displays are already open. The menu shows the
names of these windows. By clicking on the name of a window, this window will
come to the front. The Window Menu also contains a number of options which
can be used to arrange the windows on your screen in a particular way. There
are three arrangements:

« Cascade
« Tile vertically
« Tile horizontally

Section 4.1 shows the different ways that you can display weather information
using WeatherCast. Following these instructions will allow the optimal use of
WeatherCast.

18
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4.1 Weather Forecasts
When you select Weather Forecast from the View menu you have a choice of:

« Short or medium range text forecast
« Tabular forecasts containing hourly, 3-hourly or daily data
« Graphical forecasts containing hourly, 3-hourly or daily data

4.1.1 Text

The text view describes the forecast weather for one or more regions. By default,
the most recent forecast is displayed. If you have collected forecast information
for more than one region, you can select a particular region by clicking on the tab
containing the name of that region.

When starting a new text view, the most up-to-date forecast is displayed by
default. If you have downloaded a new weather forecast while the text window
was open, you can refresh the forecast text by clicking on the arrow to the right of
“Forecast issued:” This will generate a list by date and time of all of the weather
forecasts you have downloaded in the past week. The most recent forecast
appears at the top. You can select a particular forecast by clicking on the
appropriate date and time.

P2 @
Forecast izsued: !M-:unu:la_l.l 30 Apr 2007 0&:00 _:I

tbonday 30 Apr 2001 0500
Monday 30 Apr 2001 05:00
Sunday 29 Apr 2001 1700
Sunday 29 Apr 2001 12:00
Thursday 26 Apr 2001 13:00

Thursday 26 Apr 20071 05:00 —
Wednesdap 25 Apr 2001 12:00

Tueszday 24 Apr 2001 0600 it
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4.1.2 Table

The table displays the weather forecast for one or more regions and a diverse
number of weather elements expressed as figures.

EWealhelCasl [_]=]

File  Communication “iew Image ‘window Settings Help

cHE s A ENENEE| D B CEER | BEEE| 2 @ 2 &

P Hourly forecast -table- (1] [_ O] ]
Forecast issued: ;Sunday 11 Feb 2001 13:00 _ll
Montrose I
Time ‘Weather type Precipitation | Precipitation | Precipitation type | Tempetature | 'wind speed|'wind direction| Masimun wind | Temperature | Dew-paint | Visibility | Efl &

amount | probability [%]]  when present 1.5m[*C) 10m [mph) 10m gust 10m [mph) | 10cm [*C) 1.5m ['C) [km] | clou
[mrmhir] It

Sun 11 Feb 2007 20:00

Sun 11 Feb 20071 21:00 Mainly cloudy 0.0 10 Rain 1.9 2358 5w 327 g 99 242
Sun 11 Feb 2001 22:00; Hainly cloudy oo 15 Rain 116 2356 55w 3249 1.5 o0 24E
Sun 11 Feb 20071 23:00 M aiinly cloudy i} 10 Rain 118 233 S5W 327 15 0.0 225
ton 12 Feb 2007 0000 Mainly cloudy 0.0 10 Fiain 115 23 S5W 322 1.4 9.9 181
Mon 12 Feb 2007 01:00 Mairly cloudy 0.0 10 i 115 228 55W 2 1.4 9.9 156
Mon 12 Feb 2001 02:00 Mainly cloudy 0.0 10 g 11.4 228 S5W s n3 99 138
Mon 12 Feb 2001 0300 M aiinly cloudy ] 10 ¢ 114 224 S5W 313 13 48 131
Mon 12 Feb 2001 04:00 Mainly cloudy i} 10 5 114 221 S5W 304 n3 48 131
ton 12 Feb 2007 0500 Mainly cloudy 0.0 10 e 1.3 219 S5W 306 nz 9.8 125
Mon 12 Feh 2001 06:00) M ainly cloudy 0.0 5 o 1.3 217 55w 304 naz 4.8 123
Mon 12 Feh 2001 07:00 Mainly cloudy 0.0 5 Rain 1.2 215 55w an 1 97 129
Mon 12 Feb 2001 08:00 Mainly cloudy oo & Rain 12 213 S5W 298 1 a7 126
ton 12 Feb 2001 0300 M ainly cloudy 0.0 10 FRain 1.3 208 S5W 289 1.4 9.8 128
ton 12 Feb 2001 1000 Mainly cloudy 0.0 10 Fain 1.3 1949 S5W 28 .8 10,0 125
Mon 12 Feh 2001 11:00 Overcast 0.0 15 Rain 11.4 1958 55w 271 121 101 122
tdon 12 Feb 2001 12:00 Overcast oo 15 Rain 11.4 18 55w 26.4 123 oz 1256
Mon 12 Feb 2001 13:00 Overcast <01 40 Rain 106 174 S 245 1.4 45 140
ton 12 Feb 2001 14:00 09 65 96 163 W 228 105 a9 140
ton 12 Feb 2007 1500 12 85 87 15 W 21 9.4 a2 101
tan 12 Feb 2001 16:00 Continuous moderate rain 1.0 79 Rain 83 143 Nw/ 133 a7 i 101
ton 12 Feb 2001 17:00 X3 &0 79 136 MW/ 152 7.8 72 101
Mon 12 Feb 2001 18:00 0& il 76 13 HNW 181 75 E7 83
hion 12 Feb 2001 15:00 Contirwous light rain 05 35 Fain 74 1258 NNW 17.4 7.2 B3 a3

tdon 12 Feb 2001 20:00 118 16.6

‘Dialmg

[
i Start |J A& @] [ aE i “ (3 Explori.. | 5] Find: Fi. || g Weat .. EAdobe...I o Made. I B Inbow - ! WM\cros...I

On right-clicking on the table, you have the choice of:

* Changing font

» Changing weather elements

» Saving table settings

* Printing the table

» Exporting the table into another application

Weather elements

You can decide which weather elements you wish to be included in the table
display. Once you have selected the Elements option, two lists appear: one with
all available elements and one with selected elements. The selected ones are
those that are currently included in the table display. You can remove one or
more elements from the table display by highlighting them in the list of selected
elements and transferring them to the list of available elements. This transfer is
accomplished using the four arrow buttons. The buttons with a double arrow
transfer all elements. The buttons with a single arrow transfer only the elements

20
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selected for transfer. Once you have clicked OK, the table will be displayed with
the new set of weather elements. The table layout can be saved using the option
Save Table Settings.

Save Table Settings

It is possible to customise the order in which the columns appear in a table. To
do this, you left-click on the title of a column and hold down the left mouse
button. Now drag the column to the required location. Once you release the
mouse button, the column will appear in the new location. You can save the new
table layout by right-clicking on the table. A pop-up menu will appear. You can
now save the new table layout by left-clicking on the Save Table Settings
option.

4.1.3 Graphs

To view the graphs of the various forecast data, select hourly, 3-hourly or daily in
the Weather forecast area of the View menu.

You can also display the values on each graph by left-clicking on a line or bar
within the graph.

¥ weatherCast - [3-hourly forecast -graph- (1] | BEE
& Eile Commurication Miew |mage Window Settings Help ;Iili]
cHE2e A EEEHEDN Dn CEER kEsE 2|0 2 &

Forecast issued ‘wednesday 14 Mar 2001 08:00 j
Shourly forecsst Mortose |

[[] Termperaturs

Precipitation probabilty

i+ [] Temperature 10cm

i+ [[] Road surface temperature
- [ Dew-point 1.5m
| wind chill temperature

| Bridge deck temperature

SH EH RN RN R RN RN RN RN EM RN

70

65 &0 0 50 60 60

B0 ==

- ’_l Maxirurm wind gust 10m 5 = S S S S s
w- [] Incaming solar radiation

504 5

40 35

35 o

a0 25 35 55 25 5 25 25

25 0 20 20

20 15 1515 15 = 1515

1200 1800 OG:00 D00 1200 1500 00:00 000 1200 1500 0000 0600 1200 1500 0000 D00 1200 1800 00:00 0500
1403 1403 1503 1503 1503 1503 1603 1603 1603 1603 1703 1703 1703 1703 1803 1803 1803 1803 1903 1903

Time.

Mo data callected (15:45:25) | Mon 20 Apr 16:05
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4.2 Observations

Information about the weather as it has occurred can be downloaded in the form
of Observations. The weather as it occurs is recorded up to every hour, on the
hour, with respect to most weather elements. The latest data are available at 30
minutes past the hour. However, some recording stations do not report all
weather elements and some only report every three or even only every six hours.

Having selected Observations from the View Menu, you can now choose
between three display options:

* Table
* Graph
* Map

4.2.1 Observations Table

The table will view the observations from one or several weather stations in the
form of figures representing the various weather elements. With the table, it is
easy to read the exact values. You can select a particular weather station by
clicking on the tab with the name of that weather station. Using the scroll bars,
you can move through the table in the horizontal and vertical directions. The
description of the weather elements (top row) and the time indication (leftmost
column) remain frozen and therefore always visible.

22
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EWealhEICasl HE

File Communication View |mage Window Setings Help

cHEgw|AAEEIHEF| B | = BEEES O 2@
Eﬂbselvaliuns -table- [1) =
Bedford I Stansted I Guernsey | Jersey !
Time Frecipitation | Temperature | Dew-point | Relative | Visibility |"Wind direction |'\Wind speed | Pressure “ind chill Maximum &
arnournt 1.5m ('C) 1.5m ("C) | hurnidity (k) 10m 10rm (mpah) (hFa) ternperature 1.5m | ternperature 1.5
[rmmBhrs) (2] rc J{]
tdon 30 Apr 2001 10:00 0o 94 20 B0 75 N 9.2 10130 18
tdon 30 Apr 2001 09:00 0.0 85 17 52 7.2 M 10.3 imz.z2 04
don 30 Apr 2001 08:00 0.0 6.6 1.3 59 B9 M 12.8 1011.8 -0.3
tdan 30 Apr 2001 07:00 0.0 53 15 77 64 ¥ 10.3 o112 -0.8
ton 30 Apr 2001 06:00 0.0 39 1.0 81 6.5 & 64 10105 -0.8
tdan 30 Apr2001 05:00 0o 40 .2 95 6h ™ 64 10104 -0.8
tdan 30 Apr2001 04:00 0o 49 24 84 %1 ™ 58 1009.8 -0.49
on 30 Apr 2001 03:00 0.0 47 22 84 6.6 MNMNE 6.4 1008.5 -0.4
tdon 30 Apr 2001 02:00 0o 5.2 14 78 7.0 MNE 6.4 1008.4 -0.4
tdon 30 Apr 2001 01:00 0o 6.0 28 80 74 MNE 6.4 1008.2 -0.6
tdon 30 Apr 2001 00:00 0o 6.4 in 78 75 NMNE 58 1007.7 -0.4
Sun 29 Apr 2001 23:00 0o 71 33 7 76 NE 47 1007.8 0.0
Sun 29 Apr 2001 22:00 0o 7B 31 73 77 NE 63 1006.9 0.2
Sun 29 Apr 2001 21:00 0o &8 12 59 75 TN 34 1006.2 88
Sun 29 Apr 2001 20:00 0o a7 1.2 56 7.8 I 34 10051 9.7
Sun 29 Apr 2001 19:00 1.0 105 01 48 a0 TN 47 1004.8 24 1z
Sun 29 Apr 2001 18:00 0.0 1.2 -1 41 7.8 W 5.8 1004.5 37
Sun 29 Apr 2001 17:00 0.0 1.8 2 41 7.7 L 8.1 1004.1 44
Sun 29 Apr 2001 16:00 0o 121 44 1.7 Sy 10.3 1003.7 4.8
Sun 29 Apr 2001 15:00 0o 12.2 -0.2 43 7.8 WS 12.8 1003.4 44
Sun 29 Apr 2001 14:00 0o 11.3 48 a.0 Sy 12.8 1002.9 38
Sun 29 Apr 2001 13:00 1.0 11.6 23 53 a0 WS 12.8 1003.0 4.2
Sun 29 Apr 2001 12:00 0o 10.5 1.7 55 74 Sy 1.6 1002.7 24
Sun 29 Apr 2001 11:00 0o a0 44 73 77 SEW 116 1002.3 14
Sun 29 Apr 2001 10:00 0o 6.3 5B 83 78 SEW 103 1001.7 0.8 -

| |Dala callection and processing completed 11:28:37 | ton 30 Apr11:32

By right-clicking on the table, five tasks can be performed:

» Select period

* Change font

* Weather elements

» Save table settings

* Print

» Exporting the table into another application

Period

This allows you to specify the start and end time of a view as well as the
frequency of the view, i.e. a view every hour, every three hours or every six
hours.
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Elements

You can decide which weather elements you wish to be included in the table
view. Once you have selected the Elements option, two lists appear: one with all
available elements and one with selected elements. The selected ones are those
that are currently included in the table display. You can remove one or more
elements from the table display by highlighting them in the list of selected
elements and transferring them to the list of available elements. This transfer is
accomplished using the four arrow buttons. The buttons with a double arrow
transfer all elements. The buttons with a single arrow only transfer the elements
selected for transfer. Once you have clicked OK, the table will be displayed with
the new set of weather elements. The table layout can be saved using the option
Save table settings option.

Save table settings

It is possible to customise the order in which the columns appear in a table. To
do this, left-click on the title of a column and hold down the left mouse button.
Now drag the column to the required location. Once you release the mouse
button, the column will appear in the new location. You can save the new table
layout by right-clicking on the table. A pop-up menu will appear. You can now
save the new table layout by left-clicking on the Save table settings option.
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4.2.2 Observations graph

In the graph view, observations are expressed as lines or bars for one or several
weather elements. You can select a particular weather station by clicking on the
tab with the name of that weather station. You can also display the values in a
graph view by left-clicking on a line or bar within the graph.
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You can decide which weather elements you wish to have included in the graph
view by using the observations ‘tree’ on the left hand side of the display.
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4.2.3 Changing measurement units

It is possible to change the measurement units for forecast and observational
data presented in the tables and graphs. Select Settings, then User and click
the Units tab. In this box you can change the measurement units for:

* Wind speed

* Wind gust speed
* Wind direction

» Cloud Cover
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4.2.4 Observations Map

By selecting the Map option, the observations are displayed on a map with
respect to one or several weather stations. The observations are expressed as a
figure or symbol on the map at the location of the weather station concerned.
You can change the type of weather element being shown on the map using the
elements ‘tree’ on the left-hand side of the display.

You can also change the weather element that is expressed on the geographical
map by default. For this, you should select the Map views option from the
Settings menu. From there, you select Observations settings. You are then
presented with a window in which you can select which weather element you
would like to be shown on the map by default.
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4.3 Radar images

The radar images provide information regarding the position and intensity of
areas of precipitation present above the British Isles. The information is collected
by 15 precipitation radar systems located across the British Isles. One such
system is located at Clee Hill in Shropshire. Others include Wardon Hill in Dorset
and Castor Bay in Northern Ireland. These systems emit radar waves which are
reflected by the precipitation and are subsequently received back by the radar.
From the reflected and returned waves, it is possible to deduce where
precipitation is present and how intense it is.

The radar systems each have a range of 250-300 km. Any precipitation present
further afield is considered to be ‘below the horizon’. Combining information from
each of the radar systems allows a coverage over the majority of the British Isles.
This area is filled on screen by 270 x 300 pixels. Each pixel covers an area of
5.15 km x 5.15 km. A pixel can indicate one of six possible intensities. The
program depicts these intensities through six different colours.

When using the radar images, you should take account of possible inaccuracies
which can occur.

You can click on a radar image with the right button of your mouse. This will bring
up a drop-down menu to make various changes to the display. You can also
make changes to the radar display options by selecting Radar GB/IRL from the
Map view option in the Settings menu.

4.3.1 What information do the radar images provide?

The radar images show you where rain, snow, freezing rain or hailstones are
falling across the British Isles. The radar data are superimposed in colour onto a
geographical map. The colours indicate the intensity of the precipitation. You can
change the colours in the Settings menu by using the Map views option.

The radar images are very up-to-date. A new radar image is available every
guarter of an hour. These new images can be downloaded from the computer
system at PA WeatherCentre at 15 minute intervals.

By running a number of sequential radar images as a movie, you can observe
the track of precipitation areas. In addition, it is possible to indicate on the images
what type of precipitation is falling by using observations. If there is no
precipitation, the amount of cloud coverage is displayed.

The date and time of the radar image is always indicated in the title bar of the
window. You can see an example of this in the picture below.
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The radar images also allow for a precipitation forecast. Using the most recent
precipitation map, the precipitation maps for the next two hours are calculated.
This is done using a computer model. It uses the forecasted wind force and wind
direction to shift the most recent precipitation map forward at quarter of an hour
intervals. When using these forecast precipitation maps, you should be aware
that changes in the shape and size of the areas of precipitation are not shown in
the forecast maps. Forecast radar images are identified when red dots appear
on the perimeter of the UK map (see example above).

4.3.2 Display of radar images

You can start the display of radar images by selecting the option Radar images
in the View menu. The tool bar contains an icon which allows you to start the
display of precipitation maps directly.

The radar images are superimposed onto a geographical map. The intensity of
the precipitation is indicated by different colours and may vary from drizzle to
heavy precipitation. You can find a key to the intensities represented by the
colours by right-clicking on the radar image and selecting Intensity legend.
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In addition to precipitation intensities, the following data can be displayed on the
map:

e Name of a Town
* Main Roads

e Grid

* Observations

There are three ways of choosing a town on the map:

1. After you have installed WeatherCast, the program will choose London by
default. You can change the default by selecting the option Map views from
the Settings menu and then clicking the tab Map GB/IRL. The place name
selected here will become the default town shown on the radar images.

2. By left-clicking on a particular area of the map the nearest town will be shown
automatically.

3. Finally, you can search for a place using its name. Right-click on the map. A
pop-up menu will appear from which you should select the option Search
location. You can now enter the name of the place you are looking for.

You can zoom in to see the radar image around the selected town in greater
detail. Zooming out again allows you to see a larger are of the map.

Zoom In and Zoom Out can be selected by:

« Choosing either Zoom tool in the Image menu.
« Right-clicking on the map and choosing either tool from the menu.
« Clicking on the icons with the magnifying glass in the tool bar.

Observations
There are two ways of displaying the observations on a radar image:

« Select the option Map views in the Settings menu. Click on the Map GB/IRL
tab and tick the selection box Weather symbols. This setting will be saved
even after WeatherCast has been exited and restarted.

« Right-click on the map. Next, select Weather Type from the Elements option.

The observations are displayed every hour on the hour. The number of
observations on the radar image may vary from hour to hour because not all
stations report observations on an hourly basis. The following summary lists all
the symbols and their meaning.
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Meaning
fog

L

thunder with rain or snow

4

Rty B,

thunder with hailstones
hailstones

black ice
snow
sleet

rain

0/8 sky cover (clear)

1/8 sky cover (almost clear)
2/8 sky cover

3/8 sky cover

4/8 sky cover (cloudy)

5/8 sky cover

6/8 sky cover

718 sky cover (mostly cloudy)

L1 4 SIS IO gt AW

8/8 sky cover (overcast)

If you right click on a radar image the following options become available on a
menu:

Period

This allows you to tell WeatherCast how which radar images to display. You can
display only the most recent images you have downloaded or a number of
images up to a selected time. You can also turn the forecast images on and off.
Search location

This allows you to search for a particular town from a list of over 2000. When you

select a particular name, that name will automatically be highlighted on the radar
image.
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Intensity legend

Clicking on this option displays the precipitation intensities with their
corresponding colours in a separate window. These intensity colours can be
changed. The window with intensity data is always presented as the active
window.

Overlays

Further detail can be added to the map including 10km and 25km grids together
with the road network.

Element choice

You can overlay observed weather elements onto the image.

Print

You can send the image to be printed on the printer attached to your PC.
In and out zoom

You may zoom into and out from the selected location on the image.
Total zoom out

This zooms back out completely in one go.

Zoom factor

This defines the amount of that you will zoom per click of the in or out zoom
options.

Play animation, Stop animation, Newest image, Next image, Previous
image, Oldest image

The animation will automatically start. After selecting Stop animation, you can
control which image to display (Newest, Oldest etc) or begin the animation again.
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4.3.3 Radar image settings

The Map views option in the Settings menu gives access to the Radar GB/IRL
tab where you can enter how many radar images should be displayed. You can
also set the speed at which the animation should run. Finally, you can also
indicate whether forecast precipitation images should be displayed. Settings are

saved, even after WeatherCast has been exited and restarted. You can also
make changes to the settings of the map itself, including the colours, which

overlays to display by default and which town should automatically be

highlighted.
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4.3.4 Faults and Inaccuracies in Radar Images
False Reflections

Sometimes precipitation is indicated on a radar image whereas in fact no
precipitation is actually present. These occurrences are known as ‘false
reflections’. They can often be recognised by their patchy structure. In many
cases, false reflections are caused by an ‘inversion’. The general state of the
atmosphere is such that the temperature just above ground is highest, with the
temperature reducing as one moves higher into the atmosphere. In the case of
an inversion, the temperature actually increases rather than reduces as one
moves higher up through the atmosphere.

These inversions can reflect radar waves making the receiving radar system
assume there is rain present in the atmosphere when actually it is dry.

The observations are a means of recognising false reflections. Observations are
made from the ground of the type of precipitation which is falling. Updates of the
type of precipitation can be re-displayed on the radar image once every hour. A
false reflection is occurring if no precipitation is observed on the ground, while
the radar image indicates precipitation to be falling.

Absence of Reflections during Precipitation

There may be times when you can see precipitation outside which does not show
up on the radar image in WeatherCast. This will be for one of two reasons. The
first is that the radar system that extends over your location is malfunctioning. It
will therefore not have sent any information to PA WeatherCentre. This means
that PA WeatherCentre unable to include data from that system in the radar
image.

The second reason concerns very small precipitation elements, for example fine
drizzly rain or small grains of snow. These reflect few or even no radar waves. As
a result, the radar image displays no precipitation when in fact very light
precipitation is actually occurring.

The Observations are a useful addition. Overlaying the observations onto the
radar image will indicate whether or not such fine precipitation is occurring but
not being picked up by the radar system.
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Precipitation at Great Distances

Because of the curve in the earth’s surface, the beam of the radar overshoots the
highest showers towards the edges of the geographical map. Because of this,
the reflections from areas of precipitation and from showers at the edges of the
map area are often weak, while the intensity of the precipitation appears to
increase as the area approaches the radar.

4.4 Weather maps

The weather maps are weather forecasts which have been generated
automatically by a computer model. WeatherCast can display maps of the
following:

* Atmospheric Pressure
* Precipitation
* Temperature

The weather maps are updated daily. The new weather maps for WeatherCast
are available each day, in the morning. You can download the weather maps by
selecting Data collection from the Settings menu. In the window, you need to
select the weather maps that you wish to download in the Forecast box (putting
a tick in the box). You can also select the specific day that you require forecast
information for.

You can start viewing the downloaded weather maps by selecting Weather
maps from the View menu and then the required type of map. For each type,
four successive maps are always available. You can browse through the maps in
the same way as with radar images.
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4.4.1 Atmospheric Pressure Maps

In the atmospheric pressure maps, lines known by meteorologists as isobars join
up places with the same atmospheric pressure. Along these lines the forecast
atmospheric pressure is indicated. The wind blows clockwise around a high
pressure area and counter-clockwise around a low pressure area in the northern
hemisphere. The positions of the high and low pressure areas thus determine
from which direction air is feeding into the British Isles. The wind direction is
roughly parallel to the lines on the pressure map. The smaller the spacing
between two adjacent lines, the stronger the wind will be in that area. The title
bar contains the date and time of the atmospheric pressure map being viewed.
The pressure maps represent the forecast pressure pattern for 1200GMT today
and nine days into the future.
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4.4.2 Precipitation Maps

A precipitation map displays the forecast amount of precipitation over Europe.
The forecast amount of precipitation is expressed on the map in different colours.
Along the edges of the precipitation areas, the precipitation is indicated in
millimetres. A precipitation map displays the amount of precipitation forecast for
either, a period of six hours or for by daily amount. The title bar indicates the date
and time of the map. Daily precipitation maps are available for today plus the
following five days, with 6-hourly precipitation forecast maps available for today
plus three days.

m\veathell:asl

File _qumunicah:un ':\__p’_iaw imaga _V_\f']nduw Q‘Etliﬂgs ﬂe]p

CHE g A0 WH: HEE| 36 GEARE bEkK 2 0 2@

EPrecipilaliun maps -daily- [1) [(Mon 30 Apr 01:00 - Tue 1 May 01:00 - proce [H[=] B3 ﬁPIecipilaliun maps -6 hourly- (1] [(Mon 30 Apr 01:00 - Mon 30 Apr 07.00 - p =] BT

[Nor data callected (05:0215) [ lan 30 Apr 10:46

37
PA WeatherCentre Ltd.



4.4.3 Temperature Maps

The temperature maps displays the forecast air temperature across Europe. The
forecast air temperature is expressed in different colours and figures. A legend is
included in the top-left corner of the temperature map. The dividing line between
temperature above and below freezing point is shown as sharp line between the
green and a blue areas.

There are temperature maps for both (night-time) minimum and (daytime)
maximum temperatures, both of which provide forecast information for today plus
the following nine days. As with all of WeatherCast's European weather maps,
you can select the specific day you require forecast information for.
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4.5 Satellite images

The satellite images provide information regarding the cloud coverage over
Europe. The satellite photographs in WeatherCast are taken by the European
meteorological satellite Meteosat. Two types of satellite photograph can be
displayed:

« Visible light
* |nfra-red

The big disadvantage of visible light satellite images is that cloud is not visible
once the sun no longer illuminates the earth’s surface. Infra-red satellite images
are based on temperature-sensitive recordings. Because of the temperature
differences between the clouds and the earth’s surface, it is possible to obtain
cloud coverage information 24 hours a day. Satellite images are available every
hour. They are available to WeatherCast 50 minutes past the hour. You can
display satellite images by selecting the Satellite images option in the View
menu. The original satellite images consist of shades of grey. The satellite
images for WeatherCast are processed so that the cloud coverage is
superimposed on a colour map.
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